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1 Purpose 
This document was created to support applicants in applying for the State Digital Equity Capacity Grant 
Program: Native Entities (2024). To avoid confusion with the State Digital Equity Grant Program where 
the eligible applicants are States (including D.C. and Puerto Rico) & U.S. Territories, this document refers 
to the program as the Native Entity Digital Equity Capacity Grant Program (“NE Capacity & Planning 
Grant Program”). While applications for this grant can be submitted via other means (NTIA Grants Portal 
(NGP)) per the State Digital Equity Capacity Grant Program Notice of Funding Opportunity (NOFO) 
Section III.C.8, this document focuses on providing guidance for applicants intending to submit via email, 
mail, or courier (“Offline Applicants” and “Offline Applications”). This document is intended solely to assist 
applicants in better understanding the NE Capacity & Planning Grant Program made available through 
the NOFO and the requirements set forth in the NOFO for this program. Per the NOFO Section III.B, 
eligible entities for this grant are Indian Tribes, Alaska Native entities, & Native Hawaiian organizations, 
herein referred to as “Native Entities.” 
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2  Application Guidance Overview 
This document provides information to familiarize applicants with the NE Capacity & Planning Grant Program’s 
Offline Application materials and provides guidance on where to access forms and templates and how to 
complete the application package.  

The document is structured into the following three sections: 

1. Program Guidance: This section highlights application provisions, eligible entities, key submission 
dates, and final considerations for a successful application. 

2. NE Capacity & Planning Grant Program Application Instructions: Applicants will find instructions 
on how to properly fill out their NE Capacity & Planning Offline Application for the NE Capacity & 
Planning Grant Program.  

3. Technical Guidance: Applicants will find technical instructions to confirm their application materials 
are successfully downloaded, packaged, and submitted.  

Additionally, documents captured in Section 4.1.2 of this document are available online on the Digital Equity 
Program page and are found in the Native Entity Capacity & Planning Grant Program – Offline ZIP folder 
for download. 

Note: The guidance is intended for applicants submitting through email, mail, or courier. An additional NE 
NTIA Grants Portal Application Guidance document is available for guidance on submitting applications 
through the NTIA Grants Portal. 

  

mailto:internetforall@ntia.gov
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3 Program Guidance 
3.1 Before You Get Started 
Before preparing and submitting an application, applicants are encouraged to read the statutory authority 
(47 U.S.C. 1723, part of the Digital Equity Act of 
2021 (“Digital Equity Act”)), the State Digital 
Equity Capacity Grant Program NOFO focusing 
on Section III, this NTIA Grants Portal 
Application Guidance, and the Digital Equity (DE) 
Program page on www.InternetForAll.gov with 
particular attention the application resources, 
webinars, and other technical assistance 
materials. 

By carefully reviewing these materials, applicants 
will help confirm that their application is complete 
and satisfies the requirements of the program.  

Please note that all applicants are required to be active and registered in www.SAM.gov and 
have a Unique Entity Identifier (UEI) number at the time of application and for the duration of 
the NE Capacity & Planning Grant Program. Having a UEI does not automatically mean you 
are registered on SAM.gov. Please confirm you can log in to your existing account or 
register a new account on SAM.gov to complete your registration. For more information on 

how to register for SAM.gov, applicants may reference NTIA’s SAM.gov Applicant Guidance. To find the 
NE Capacity & Planning Grant Program on SAM.gov, applicants should reference the following funding 
opportunity title and CFDA number listed on the NOFO: 

3.2 Standard Terms and Conditions for Department of Commerce Grants 
All recipients are required to comply with all applicable provisions set forth in the following: 

• Uniform Administrative Requirements, Cost Principles and Audit Requirements: Through 2 C.F.R. 
§ 1327.101, the Department of Commerce adopted Uniform Administrative Requirements, Cost 
Principles, and Audit Requirements for Federal Awards at 2 C.F.R. Part 200, which apply to 
awards in this Program. Refer to http://go.usa.gov/SBYh and 2 C.F.R. Part 200. 

• Department of Commerce Financial Assistance Standard Terms and Conditions: The Department 
of Commerce will apply to each award in this Program, the Financial Assistance Standard Terms 
and Conditions in effect on the date of award. The current version, dated October 1, 2024, is 
accessible at Department of Commerce Financial Assistance Standard Terms and Conditions. 

• Pre-Award Notification Requirements: The Department of Commerce will apply the Pre-Award 
Notification Requirements for Grants and Cooperative Agreements dated December 30, 2014 (79 
FR 78390), accessible at http://go.usa.gov/hKkR.  

Registering with System Award Management 

To register or check your SAM.gov registration, go to 
www.SAM.gov and complete the online SAM 

registration process to obtain a UEI (SAM) or verify if 
your organization already has one. Note that a new 

SAM.gov registration or renewal of an expired 
SAM.gov registration can take two weeks or more to 

process after being submitted on SAM.gov. 

 

Catalog of Federal Domestic Assistance Number and Funding Opportunity Title 

The Catalog of Federal Domestic Assistance (CFDA) number for the NE Capacity & Planning 
Grant Program is 11.032 and the title is State Digital Equity Capacity Grant Program 

mailto:internetforall@ntia.gov
https://uscode.house.gov/view.xhtml?req=granuleid:USC-prelim-title47-section1723&num=0&edition=prelim
https://www.ntia.gov/federal-register-notice/2024/notice-funding-opportunity-state-digital-equity-capacity-grant-program
https://www.ntia.gov/federal-register-notice/2024/notice-funding-opportunity-state-digital-equity-capacity-grant-program
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http://www.sam.gov/
https://broadbandusa.ntia.gov/sites/default/files/2024-06/SAM.gov_Guidance.pdf
http://go.usa.gov/SBYh
https://www.ecfr.gov/current/title-2/subtitle-A/chapter-II/part-200
https://www.commerce.gov/sites/default/files/2024-09/DOC%20Financial%20Assistance%20General%20Terms%20and%20Conditions%20as%20of%2001%20October%202024.pdf
http://go.usa.gov/hKkR
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3.3 Native Entity Capacity & Planning Grant Program Eligible Entities 
To apply, Indian Tribes, Alaska Native Entities, 
and Native Hawaiian organizations must appear 
on one of the following lists prior to the closing of 
the application window: 

• U.S. Department of the Interior, Bureau of 
Indian Affairs, Indian Entities Recognized 
by and Eligible to Receive Services from 
the United States Bureau of Indian Affairs, 88 Fed. Reg. 2112 (Jan. 12, 2023), available at: 
https://www.federalregister.gov/documents/2023/01/12/2023-00504/indian-entities- recognized-
by-and-eligible-to-receive-services-from-the-united-states-bureau-of; 

• Alaska Department of Natural Resources, Division of Mining, Land and Water, Index of Regional 
Native Corporations, available at: https://dnr.alaska.gov/mlw/paad/17b-easements/search/; 

• U.S. Department of the Interior, Office of Native Hawaiian Relations, Native Hawaiian 
Organization Notification List, available at: https://www.doi.gov/hawaiian/nhol; 

• U.S. Department of the Interior, Office of Native Hawaiian Relations, Homestead & Beneficiary 
Associations List, available at: https://www.doi.gov/hawaiian/homestead-beneficiary-associations; 
and 

• The Department of Hawaiian Home Lands. 

3.3.1 Non-profit Corporation 
Additionally, a Native Entity on one of the lists identified above may appoint a non-profit corporation 
authorized by the governing body of the Native Entity to administer Capacity and Planning Grant Funds 
on behalf of the eligible Native Entity. If a Native Entity intends to utilize an authorized non-profit 
organization for this purpose, the Native Entity should identify the organization in its application and 
discuss the role and activities of such organization.  

A non-profit corporation that is not a Native Entity cannot be the lead applicant. Non-profits can only be 
appointed by a Native Entity to administer Digital Equity Capacity Grant Program funds and Digital Equity 
Planning Grant Program funds on behalf of the eligible Native Entity. 

3.3.2 Additional Eligibility Requirements 
• Applicants must obtain authorizing documentation (e.g., Tribal Government Resolution or 

equivalent formal authorization) from the governing body of the Native Entity providing express 
authority to file an application for (1) Capacity Grant Funds or (2) Capacity & Planning Grant 
Funds on behalf of the Native Entity.  

• A Native Entity may either apply as a single applicant or part of a consortium but may only submit 
one application as outlined in the NOFO.  

• If applying as a consortium, the lead applicant must submit:  

o Authorizing documentation (e.g., Tribal Government Resolution or equivalent formal 
authorization) from the governing body of each participating Native Entity in the 
consortium and 

Any eligible entity that intends to apply is referred to 
as an “applicant” in this document. Note that this 

application guidance is for Native Entities (Indian 
Tribes, Alaska Native entities, and Native 

Hawaiian organizations). 

mailto:internetforall@ntia.gov
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https://www.federalregister.gov/documents/2023/01/12/2023-00504/indian-entities-%20recognized-by-and-eligible-to-receive-services-from-the-united-states-bureau-of
https://dnr.alaska.gov/mlw/paad/17b-easements/search/
https://www.doi.gov/hawaiian/nhol
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o A Memorandum of Understanding (“MOU”) with each Native Entity participating in the 
consortium demonstrating approval of the proposed projects and clearly articulating the 
specific benefits and responsibilities of each member. 

3.4 Authorization by Governing Authority 
Documentation of authorization to apply on behalf of a Native Entity should be in the form of a Tribal 
Resolution of Consent for Indian Tribes and for Alaska Native entities. For Native Hawaiian 
organizations and other Native Entity organizations that do not use Tribal Resolutions, they must provide 
an equivalent formal authorization from the governing authority of the Native Entity. Native Entity 
formal authorization elements include:  

• Name of the eligible Native Entity (which shall appear on the List of Eligible Native Entity 
Organizations) 

• Express authority to file an application for (1) Capacity Grant Funds or (2) Capacity and Planning 
Grant Funds 

• Signature of a leader within the governing authority and/or other governing body (e.g. the Tribal 
Council, Native Hawaiian organization President) 

• Signature date after March 25, 2024 (NOFO Release Date)  

3.4.1 Authorization for Consortium Applications 
In the case of consortium applications, each member of the consortium application is required to submit 
documentation of an appropriate authorization from the applicable governing authority. Consortium 
applications submitted without authorizations from each Native Entity named in the application will be 
considered incomplete. 

Additionally, if applying as a consortium, the lead applicant must submit an MOU with each Native 
Entity participating in the consortium. The MOU must include the following: 

• Demonstrate each Native Entity’s approval of the proposed projects, 

• Clearly articulate the specific benefits and responsibilities of each member, and 

• Commitment from the lead applicant to stay in regular communication with each member of the 
consortium regarding the status of awards and the progress of the proposed projects described. 

Note: NTIA will consider application(s) submitted without the appropriate authorizations and agreements 
as incomplete and may remove them from consideration for funding. 

3.5 Key Submission Dates and Methods for Offline Submission 
The application window opened on September 25, 2024, and will close on February 7, 2025, at 11:59 
p.m. Eastern Time (ET). 

3.5.1 Offline Submission Methods 

All Native Entity Offline Applications must be received by NTIA via email no later than 11:59 p.m. 
Eastern Time (ET) on February 7, 2025, or sent by postal mail or courier showing evidence of mailing of 
their applications no later than 11:59 p.m. Eastern Time (ET) on February 7, 2025. In all submittal 
scenarios, NTIA assumes the last submitted version of the application is the one to be reviewed.  

mailto:internetforall@ntia.gov
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• Email: Offline Applicants should email all application content to the NTIA Digital Equity email box 
- digitalequity@ntia.gov and the email from the applicant must be received by NTIA and time 
stamped no later than 11:59 p.m. Eastern Time (ET) on February 7, 2025. Applicants are 
encouraged to list the name of the Native Entity(ies) and Grant Program in the email title. See 
Appendix B Email Submission of NE Capacity & Planning Grant Program Application for a 
proposed template to use for the email submission. If more than one email needs to be sent due 
to limited attachment capabilities, the applicant is encouraged to use the same naming 
convention for the email title and note in the body of the email this application material should be 
included in evaluation. If the applicant needs to send more than one email to provide NTIA with 
the full application, all emails must be time stamped no later than 11:59 p.m. Eastern Time (ET) 
on February 7, 2025 (see Figure 1: Sample Email with Receipt Timestamp). 

• Mail or courier: Offline Applicants must show postmark (for postal mail) or show evidence of 
mailing (for courier submissions) of their applications no later than 11:59 p.m. Eastern Time (ET) 
on February 7, 2025, and send the complete application package materials (printed or in a jump 
drive) to: 

Angela Thi Bennett 
Director of Digital Equity 
Office of Internet Connectivity and Growth 
National Telecommunications and Information Administration 
U.S. Department of Commerce  
1401 Constitution Avenue, NW  
Washington, DC 20230 

• If an applicant needs to make changes to an application ahead of the submission deadline, the 
applicant must contact NTIA by emailing digitalequity@NTIA.gov for assistance in making 
updates. Applicants are encouraged to resubmit the entire application package (e.g., Offline 
Application Form and all required documents) if the applicant wishes to make revisions ahead of 
the application deadline. 

• In the event an applicant sends multiple versions of the application, NTIA may use the last timely 
received application that is submitted. 

Note: Applications for the NE Capacity & Planning Grant Program will not be submitted via Grants.gov. 
All applications must be submitted via the NTIA Grants Portal, emailed, or sent by mail or courier.  

Figure 1: Sample Email with Receipt Timestamp 

mailto:internetforall@ntia.gov
mailto:digitalequity@ntia.gov
mailto:digitalequity@NTIA.gov
https://grants.ntia.gov/


   

 

 

Page | 11 
internetforall.gov | internetforall@ntia.gov 

Internet For All 

3.5.2 File Sizes 
Applicants are responsible for ensuring their emailed application is successfully sent to NTIA. Saving 
documents as PDFs helps reduce file sizes. Additionally, there are a few other options to reduce the 
attachment sizes, such as zipping the files. Instructions are detailed in Section 5 Technical Instructions. 

3.5.3 Application Templates 
Applicants are required to upload a number of documents using templates. To aid in an expeditious 
review of applications, these documents must: 

• be saved and uploaded (if submitting via email or mail/courier using a jump drive) in the same file 
type as the provided template or as indicated in the template, 

• use the same formatting provided in the template, and 

• not be password-protected.  

Failure to provide files consistent with the templates may result in NTIA being unable to process the 
application and may result in delays or a rejection of the application. 

The following templates are available to download on the Digital Equity Program page and found in the 
Native Entity Capacity & Planning Grant Program - Offline ZIP folder: 

• SDECGP NE Offline App Form (SDECGP NE Offline App Form) 

• NE Capacity & Planning Consolidated Budget Form (SDECGP NE CandP CBF) 

• NE Capacity Consolidated Budget Form (SDECGP NE Capacity CBF) 

• NE Capacity Consortium Members Form (SDECGP NE Consortium Members Form) 

• Standard Form 424: Application for Federal Assistance (SF-424) 

• Certification Regarding Lobbying (CD-511) 

• Disclosure of Lobbying Activities (SF-LLL) 

3.6 Offline Applications Post-Submission Processing 
Offline Applicants must submit their application by email (digitalequity@ntia.gov) or by mail or courier no 
later than 11:59 p.m. Eastern Time (ET) on February 7, 2025, per Section III.C.6 of the NOFO. The email 
from the applicant must be received by NTIA and time stamped no later than 11:59 p.m. Eastern Time 
(ET) on February 7, 2025. Applicants must show postmark (for postal mail) or show evidence of mailing 
(for courier submissions) of their applications no later than 11:59 p.m. Eastern Time (ET) on February 7, 
2025.  

The postmark date or evidence of mailing for courier submissions of the last submitted complete 
application packet shall be entered into NGP by the NTIA authorized user as the date the application was 
received. The applications submitted by email, mail, and courier will be entered into NGP by the NTIA 
authorized user following the application closing date. After the NTIA authorized user inputs the Offline 
Application into NGP, another NTIA authorizer user will confirm the application is entered exactly as 
received. The application will then be reviewed in NGP, and all communications thereafter between the 
applicant and NTIA will be performed via NGP by email.  

In the event an applicant sends multiple versions of the application, the last timely application sent may 
be the one entered in NGP and reviewed. If the latest version cannot be identified, the Initial Review 

mailto:internetforall@ntia.gov
https://broadbandusa.ntia.gov/technical-assistance/NE_Capacity_and_Planning_Grant_Program_Offline_ZIP_folder
mailto:digitalequity@ntia.gov
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Team Lead may contact the applicant to determine which application package is the one to review.  

Once the application is entered into NGP, the Authorized Organizational Representative (AOR) will 
receive an email notifying them of this process. In addition, applicants are required to create an account 
on NGP to confirm they receive all follow-up communications. Instructions on how to create an account 
are located in Appendix C. 

3.7 Follow-Up Confirmation and Communication 
Applicants are encouraged to closely monitor their emails following submission of an Offline Application. 
The NE Capacity & Planning Grant Program Team will confirm receipt of an application based on how the 
application was submitted, as outlined below. 

Emailed Application Confirmation Receipt: NTIA will acknowledge receipt of applications submitted via 
email, sent to the originating email address of the application package, within three (3) business days.   

Mail or Courier Application Confirmation Receipt: NTIA will acknowledge receipt of applications 
submitted via mail or courier within approximately two (2) weeks after the application deadline by sending 
an email to the AOR listed in the application after the application has been inputted into NGP. 

In addition, this point of contact and email address may also be used for other instances where the NE 
Capacity & Planning Grant Program Team requires follow up with the applicant. A phone call may be 
initiated to make the applicant aware of the follow-up request.  

Note: All applicants are required to have an account on NGP following close of application deadline.  

3.8 Final Considerations 
• Before applying, applicants should fully read the State Digital Equity Capacity Grant Program 

NOFO and other Technical Assistance materials available on the NE Capacity & Planning Grant 
Program page on www.InternetForAll.gov as well as the Department of Commerce’s Grants 
Manual. 

• Applicants may receive funding only for costs established in the NOFO and 2 CFR 200 as 
allowable uses of funds. 

• By applying, the applicant certifies that the information and responses in the application are 
material representations of fact and are true and correct. 

3.9 Technical Issues 
Please contact the Digital Equity Team at digitalequity@NTIA.gov if any technical issues (e.g., trouble 
downloading a form or submitting the application) arise. For all other questions, including instructions on 
how to complete the application, applicants are encouraged to use this document and other readily 
available resources on the Digital Equity Program page. 

 
  

mailto:internetforall@ntia.gov
http://www.internetforall.gov/
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mailto:digitalequity@ntia.gov
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4 NE Capacity & Planning Grant Program 
To start, Offline Applicants are required to download the SDECGP NE Offline App Form and other 
available templates on the Digital Equity Program page and found in the Native Entity Capacity & 
Planning Grant Program - Offline ZIP folder. 

The following section provides applicants with step-by-step instructions on how to complete and submit 
the NE Capacity & Planning Grant Program application via email, mail, or courier. 

Note: Many questions on the application form will have a limit to the length of the response (e.g., 2500-
character limit, approximately 500 words). Applicants are encouraged to plan their response ahead of 
time to stay within these constraints. 

4.1 Application Overview 
The following sections provide step-by-step application instructions. To help you prepare to complete the 
application, use the checklist in Table 1: Application Component Checklist to compile required information 
and the document repository in Error! Reference source not found.. 

4.1.1 Offline Application Checklist 
Use the checklist in Table 1: Application Component Checklist to organize the components of the 
application. 

Table 1: Application Component Checklist 

Application Component Action Required 

Offline Application Section 1. Application Information 

□  1.1 SAM.gov Registration Verify SAM.gov registration (NOFO Section III.C.5) 

□  1.2 Authorizing 
Documentation 

Identify your organization’s Eligible Entity type and provide 
authorizing documentation(s) (NOFO Sections III.B.1 and 
III.C.2.a) 

□  1.3 Native Entity 
Information 

Identify the Native Entity or Entities represented in the 
application (NOFO Sections III.B.1 and III.C.2.a-b) 

□  1.4 Consortium 
Information 

Identify if you are submitting as a consortium and if applicable, 
provide Consortium Members Form and Memorandums of 
Understanding(s) (NOFO Sections III.B.1 and III.C.2.b) 

□  1.5 Non-Profit Information 
Identify if a non-profit corporation will administer NE Capacity 
& Planning Grant Funds on behalf of the eligible Native Entity 
and if applicable, provide authorizing documentation(s) 
(NOFO Sections III.B.1 and III.C.2.c.vi) 

Offline Application Section 2. Project Narrative 

□  2.1 Project Information 
Provide general information on your project (e.g., project title, 
executive summary, total funding requested) (NOFO Section 
III.C.2.c) 

□  2.2 Planning Grant Funds Provide information related to Planning Grant Funds (if 
applicable) (NOFO Section III.C.2.c.iii) 

 

mailto:internetforall@ntia.gov
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Application Component Action Required 

□  2.3 Capacity Grant Funds Provide information related to Capacity Grant Funds (NOFO 
Section III.C.2.c.iv) 

□  2.4 Digital Equity 
Promotion 

Provide information on how the proposed grant projects will 
promote digital equity among the selected Covered 
Populations (NOFO Section III.C.2.c.iv) 

□  2.5 Project Size Variance 
Identify if the project size is less than $500,000 or more than 
$2,000,000 and if applicable, an explanation (NOFO Section 
III.C.2.c.v) 

□  2.6 Implementation 
Describe various aspects of the project Implementation Team 
including an upload of key personnel resumes (NOFO 
Sections III.C.2.c.vii-ix) 

□  2.7 Anticipated Outcomes 
Provide a description of the proposed outcomes and 
anticipated long-term impact on digital equity, including the 
benefits to the intended project beneficiaries, and provide the 
comprehensive project plan (NOFO Sections III.C.2.c.x-xi) 

Offline Application Section 3. Funding Information 

□  3.1 TBCP Funds Identify if you have applied for TBCP funding and if applicable, 
provide additional details (NOFO Section III.C.2.c.xii) 

□  3.2 Planning Funds 
Identify if you were awarded funding as a sub-recipient to a 
State Digital Equity Planning Grant and if applicable, provide 
additional details (NOFO Section III.C.2.c.xii) 

□  3.3 Other Funding 
Identify if you applied or have been awarded to any other 
Federal or outside funding sources and if applicable, provide 
additional details (NOFO Section III.C.2.c.xii) 

Offline Application Section 4. Certifications and Assurances 

□  4 Certifications and 
Assurances 

Answer each certification and assurance question (NOFO 
Sections III.C.2.d-f) 

Offline Application Section 5. Consolidated Budget Forms 

□  5 Consolidated Budget 
Forms 

Provide the Consolidated Budget Form with detailed budget 
information (NOFO Section III.C.2.g) 

Offline Application Section 6. SF-424 

□  6 SF-424 Complete and provide the SF-424 (NOFO Section III.C.2.h) 

Offline Application Section 7. Standard Forms 

□  7 Standard Forms Provide the completed CD-511, SF-LLL (if applicable), and 
NICRA (if applicable) (NOFO Section III.C.2.h) 

Offline Application Section 8. Attest and Submit 

□  8 Attest and Submit 
Provide your Signature, Printed Name, and Date before 
submission. AOR (Authorized Representative in SF-424) is 
required to submit the application. 

Note: Please only submit materials requested by the NE Capacity & Planning Grant Program and NOFO. 
Additional submitted materials will not be reviewed. 
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Table 2: Checklist of Application Fields That Must be Completed is provided as a guide to assist 
applicants by highlighting the fields within the application that must be completed. Please note that failure 
to complete ALL fields noted in the table below may result in the application being removed from further 
consideration. Applicants are encouraged to review their submissions carefully to ensure compliance with 
all requirements before finalizing and submitting their applications. 
Table 2: Checklist of Application Fields That Must be Completed 

  Offline Application Form Question      Offline Application Form Question  

□  1.1.1 SAM.gov Account  
  

□  
3.2.1 State Digital Equity 
Planning Grant Sub-recipient  

□  1.1.2 SAM.gov Account  
  

□  
3.3.1 Federal Grant Awards for 
Digital Equity Past Awards  

□  1.2.1 Applicant Type  
  

□  
3.3.3 Federal Grant Awards for 
Digital Equity Past Applications  

□  1.4.1 Consortium Application  
  

□  
3.3.5 Philanthropic Awards for 
Digital Equity  

□  
1.5.1 Authorized Non-Profit 
Corporation  

  
□  4.1 Use of Funds Certification  

□  2.1.4 Barriers to Digital Equity  
  

□  
4.2 Supplemental Funds 
Certification  

□  2.1.5 Covered Populations Served  
  

□  4.3 Assurance 1  

□  2.1.6 Geographic Regions Served  
  

□  4.4 Assurance 2  

□  
2.2.1 Digital Equity Plan 
Development  

  
□  

5.1.1 NE Capacity & Planning 
Consolidated Budget Form  

□  2.5.1 Variance in Project Size  
  

□  
7.1.2 Standard Form LLL, 
Disclosure of Lobbying 
Activities  

□  
2.6.6 Capacity Grant Sub-Granting 
or Sub-Contracting Process  

  
□  

7.1.4 Negotiated Indirect Cost 
Rate Agreement (NICRA)  

□  
3.1.1 Tribal Broadband 
Connectivity Program (TBCP) 
Application  

  
□  

(If Applicable) 7.1.5 Negotiated 
Indirect Cost Rate Agreement 
(NICRA)  

□  (If Applicable) 3.1.3 TBCP Award  
  

□  8 Attest and Submit  
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4.1.2 Document Repository for Download 
Applicants should download the Offline application materials included in the Native Entity Capacity & 
Planning Grant Program – Offline ZIP folder hosted on https://broadbandusa.ntia.gov. Applicants can 
refer to Table 3: Document Repository to find the list of documents needed to complete the NE Capacity 
& Planning Grant Program Offline Application. 

Table 3: Document Repository 

Document File Name in ZIP 
Folder Notes 

NE Capacity & 
Planning Offline 
Application Form 

SDECGP NE Offline 
App Form 

All Offline Applicants are required to complete the 
Offline Application Form (SDECGP NE Offline App 
Form). Save as a .pdf if submitting via email or loading 
to a jump drive. 

DE NE Capacity 
and Planning 
Consolidated 
Budget Form 

SDECGP NE CandP 
CBF 

For applicants requesting Capacity and Planning Grant 
Funds, applicants are required to complete the DE NE 
Capacity and Planning Consolidated Budget Form 
(SDECGP NE CandP CBF). Save as a .xlsx if 
submitting via email or loading to a jump drive. Do not 
password protect. 

DE NE Capacity 
Consolidated 
Budget Form 

SDECGP NE 
Capacity CBF 

For applicants requesting Capacity Grant Funds only, 
applicants are required to complete the DE NE 
Capacity Consolidated Budget Form (SDECGP NE 
Capacity CBF). Save as a .xlsx if submitting via email 
or loading to a jump drive. Do not password protect. 

DE NE Consortium 
Members Form 

SDECGP NE 
Consortium 
Members Form 

For consortium applications only, applicants are 
required to complete the DE NE Consortium Members 
Form (SDECGP NE Consortium Members Form). Save 
as a .xlsx if submitting via email or loading to a jump 
drive. Do not password protect. 

SF-424 SF-424 
Required for all applicants: Standard Form 424: 
Application for Federal Assistance (SF-424). Save as a 
.pdf if submitting via email or loading to a jump drive. 

CD-511 CD-511 
Required for all applicants: Certification Regarding 
Lobbying (CD-511). Save as a .pdf if submitting via 
email or loading to a jump drive. 

SF-LLL SF-LLL 
(If applicable) Disclosure of Lobbying Activities (SF-
LLL). Save as a .pdf if submitting via email or loading 
to a jump drive. 
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Step-by-Step Instructions for Completing the Offline Application Form 
The following instructions offer detailed information and guidance on completing the Offline Application 
Form. The section numbers correspond to those in the Offline Application Form. 

General Application Information documents must be submitted in the file format noted in Error! 
Reference source not found. if submitting via email or loading to a jump drive. See below to get started. 

Section 1 Application Information 
As part of the NE Capacity & Planning Grant Program application package applicants must complete the 
following Application Information related to their SAM.gov account and their authorizing documentation 
(e.g., Tribal Resolution or equivalent formal authorization from the governing authority of the Native 
Entity). The following instructions pertain to Section 1 Application Information of the SDECGP NE Offline 
App Form. 

Section 1.1 SAM.gov 
The System for Award Management (SAM.gov) is an official website of the U.S. Government. The SAM 
database is managed by the General Services Administration, which is responsible for acquiring goods 
and services for government agencies. To do business with any federal government agency, an applicant 
must complete SAM registration on SAM.gov. There is no cost to use SAM.gov.  

Note: Applicants who are new to SAM.gov may register their entity to receive a UEI by signing into 
SAM.gov and selecting “Get Started,” then “Register Entity.” A new SAM.gov registration or renewal of an 
expired SAM.gov registration can take two weeks or more to process after being submitted on SAM.gov. 
All applicants must register with SAM before submitting an application pursuant to this program. 
Additionally, the applicant must always maintain an active SAM registration with current information 
during which it has an active federal award or an application or plan under consideration by a federal 
awarding agency. Applicants can register for the SAM at https://www.sam.gov/. Entities without an active 
SAM.gov registration and/or UEI at the time of application submission and award may be deemed 
ineligible for a grant award.  

Section 1.1.1 SAM.gov Account  

Instructions: Using your SAM.gov account information, provide your Organization Name and SAM.gov 
Unique Entity ID (UEI), SAM.gov Activation Date, and Registration Expiration Date in the table. 

Additional Guidance: To check for your organization’s UEI and SAM.gov Expiration Date, you will need 
to log into SAM.gov and follow the additional guidance: 

1. Go to https://sam.gov 

2. Search for your organization 

3. Under “Entity Registration” the UEI and SAM.gov Expiration Date should be available on the 
screen. 
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Section 1.1.2 SAM.gov Account  

Additional Guidance: For Section 1.1.2 of the SDECGP NE Offline App Form, select Yes or No to 
answer the following question: ‘Are your representations and certifications to receive Federal Financial 
Assistance funds in compliance and up to date?’ To see if your representations and certifications (“reps 
and certs”) are in compliance and up to date, you will need to log into SAM.gov and follow the additional 
guidance: 

1. Go to https://sam.gov  

2. At the bottom of the 
page select “Check 
Entity Status” under 
“Customer Service 

3. Search for your 
organization’s UEI 

4. Verify that the “Reps and Certs” are completed 

1234 Main St  1234 Main St 

  

Unique Entity ID (UEI) 

SAM.gov 
Expiration 

Date 
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Section 1.2 Authorizing Documentation 
Section 1.2.1 Applicant Type 

Instructions: For Section 1.2.1 of the SDECGP NE Offline App Form, all applicants must select their 
respective applicant type from the list provided (Indian Tribe, Alaska Native Entity, Native Hawaiian 
Organization). See Section 3.3 of this document for a list of eligible entities. 

Section 1.2.2 Authorizing Documentation 

Instructions: If applying as a single Native Entity, you will be asked in Section 1.2.2 Authorizing 
Documentation of the SDECGP NE Offline App Form to attach a copy of the governing body’s authorizing 
documentation into your email submission or printed or saved on a jump drive if sending by mail or 
courier. The authorizing documentation should demonstrate the authority to make an application on 
behalf of the Native Entity and designating the AOR. The applicant’s name must match the name in the 
authorizing documentation. 

If applying as a consortium, you will be asked in Section 1.4.1 of the SDECGP NE Offline App Form to 
attach the appropriate authorizations from each of the Native Entities listed within the Consortium 
Members Form into your email submission or printed or saved on a jump drive if sending by mail or 
courier. The authorizing documentation should demonstrate the authority to make an application on 
behalf of each Native Entity and designate the AOR.  

Note: Authorizing documentation should be in the form of a Tribal Resolution of Consent for Indian Tribes 
and for Alaska Native Entities, or for other Native Entity Organizations, an equivalent formal authorization 
from the governing authority of the Native Entity. 

Section 1.3 Native Entity Information 
Section 1.3.1 Native Entity Name(s) 

Instructions: For Section 1.3.1 of the SDECGP NE Offline App Form, enter the name of the Native Entity 
or Entities represented in the application.  

Note: As a reminder, NTIA will permit only one application from each Native Entity. In other words, a 
Native Entity may either apply as an applicant or apply as part of one consortium. By completing this 
form, you affirm this is the sole application from your organization. 

Section 1.4 Consortium Information 
Section 1.4.1 Consortium Application  

Instructions: For Section 1.4.1 of the SDECGP NE Offline App Form, select Yes or No to answer the 
following question: ‘Are you applying on behalf of a consortium of federally recognized Indian Tribes, 
Alaska Native Entities and/or Native Hawaiian Organizations?’  

If No, you are not submitting on behalf of a consortium, skip to Section 1.5 Non-Profit Information of the 
SDECGP NE Offline App Form. 

If Yes, you are submitting on behalf of a consortium, continue Section 1.4 Consortium Information of the 
SDECGP NE Offline App Form.  

Section 1.4.2 Consortium Name 

Instruction: Provide the name of the Consortium (if applicable). 
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Section 1.4.3 Consortium Members Form 

Instructions: The Consortium Members Form must be submitted as a .xlsx attachment in the email 
submission. If an applicant is mailing their application either include as a .xlsx on a jump drive or printed 
as part of a mail or courier submission (if applicable). 

Section 1.4.4 Memorandum of Understanding 

Instructions The Memorandums of Understanding(s) must be submitted as a .pdf attachment in the 
email submission. If an applicant is mailing their application either include as a .pdf on a jump drive or 
printed as part of a mail or courier submission (if applicable). 

Note: Consortium applications should attach the Consortium Members Form as well as Memorandum of 
Understanding (MOUs). The MOU must be submitted between the lead applicant and each of the Native 
Entities listed in the Consortium Members Form. The MOU should demonstrate approval of the proposed 
projects and clearly articulate the specific benefits and responsibilities of each consortium member. 
Applicants may submit one MOU that contains all Native Entities or one MOU per Native Entity, which 
would result in multiple MOUs. The following is required for Consortium Members Form: 

• Each consortium member’s legal name  

• Each member organization’s legal identifiers 

• Identification if the member is the lead applicant  

• Identification of the type of entity 

• Each member’s corresponding role in the consortium. 

Section 1.5 Non-Profit Information 
Section 1.5.1 Authorized Non-Profit Corporation 

Instructions: For Section 1.5.1 of the SDECGP NE Offline App Form, select Yes or No to answer the 
following question: ‘Are you using a non-profit corporation authorized by the Native Entity to administer 
NE Capacity and Planning Grant Funds on behalf of the eligible Native Entity?’  

If No, you are not using a non-profit corporation authorized by the Native Entity to administer Digital 
Equity Program Capacity and Planning Grant Funds on behalf of the eligible Native Entity, skip to Section 
2 Project Narrative of the SDECGP NE Offline App Form. 

If Yes, you are using a non-profit corporation authorized by the Native Entity to administer Digital Equity 
Program Capacity and Planning Grant Funds on behalf of the eligible Native Entity, continue Section 1.5 
Non-Profit Information of the SDECGP NE Offline App Form. 

Section 1.5.2 Non-Profit Corporation Authorization 

Instructions: The authorizing documentation(s) must be submitted as a .pdf attachment in the email 
submission. If an applicant is mailing their application either include as a .pdf on a jump drive or printed 
as part of a mail or courier submission (if applicable). 

Section 1.5.3 Authorized Non-Profit Corporation Name 

Instructions: Enter the name of the authorized non-profit organization (if applicable). 
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Section 1.5.4 Authorized Non-Profit Corporation Point-of-Contact (POC) Name 

Instructions: Enter the name of the point of contact from the authorized non-profit organization (if 
applicable). 

Section 1.5.5 Authorized Non-Profit Corporation Email 

Instructions: Enter the email of the authorized non-profit organization (if applicable). 

Section 1.5.6 Authorized Non-Profit Corporation Role and Activities 

Instructions: Describe the non-profit organization's role and activities. (2500 character limit, 
approximately 500 words) 

Note: Appropriate authorization(s) from the Native Entity (or each of the Native Entities if there are 
multiple within the consortium) is required if the applicant is using a non-profit corporation to administer 
NE Capacity & Planning Grant Funds. Authorizing documentation should be in the form or a Tribal 
Resolution of Consent for Indian Tribes and for Alaska Native Entities, or, for other Native Entity 
Organizations, an equivalent formal authorization from the governing authority of the Native Entity 
authorizing the non-profit corporation to administer NE Capacity & Planning Grant Program Funds on 
their behalf.  

Section 2 Project Narrative 
The Project Narrative should address both requests for Digital Equity Capacity Grants and Digital Equity 
Planning Grants (as applicable) and provide an overall implementation strategy that describes how the 
proposed projects will serve the Covered Populations, be responsive to the program description, statutory 
purposes set forth in 47 U.S.C. § 1723(d), funding priorities, and the evaluation criteria set forth in the 
NOFO. 

Section 2.1 Project Information 
Instructions: Complete all questions in Section 2.1 of the SDECGP NE Offline App Form. 

Section 2.1.1 Project Title 

Instructions: Enter a brief title of the project. This is NOT a description but a brief title/name of the 
project. (1250 character limit, approximately 250 words) 

Section 2.1.2 Executive Summary 

An Executive Summary of the proposed project(s), including a statement on whether Digital Equity 
Planning Funds are being requested. Please note that if an applicant’s proposal is selected for funding, 
NTIA may use all or a portion of the Executive Summary as part of a press release issued by NTIA, or for 
other public information and outreach purposes. Applicants are advised not to incorporate information that 
concerns business trade secrets or other confidential commercial or financial information as part of the 
Executive Summary. See also 15 C.F.R. § 4.9(b) concerning the designation of business information by 
the applicant. 

Section 2.1.3 Total Funding Requested 

Information: Please enter the total amount of funding requested, including both Capacity and Planning, 
as applicable. 
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Section 2.1.4 Barriers to Digital Equity 

Instructions: Which of the following barriers to Digital Equity does your project seek to address? Please 
elaborate in the Executive Summary text above in Section 2.1.2. (Select all that apply) 

• The availability of, and affordability of access to, fixed and wireless broadband technology 

• The online accessibility and inclusivity of public resources and services 

• Digital literacy 

• Awareness of, and the use of, measures to secure the online privacy of, and cybersecurity with 
respect to, an individual 

• The availability and affordability of consumer devices and technical support for those devices 

Section 2.1.5 Covered Populations Served  

Instructions: Which of the following Covered Populations will be served through your project? Please 
elaborate in the Executive Summary text above in Section 2.1.2. (Select all that apply) 

• Individuals who live in covered households (i.e., households with income of not more than one-
hundred fifty (150) percent of the poverty level) 

• Aging individuals 

• Incarcerated individuals other than individuals who are incarcerated in a Federal correctional 
facility 

• Veterans 

• Individuals with disabilities 

• Individuals with a language barrier, including individuals who are English learners and have low 
levels of literacy 

• Individuals who are members of a racial or ethnic minority group 

• Individuals who primarily reside in a rural area 
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Section 2.1.6 Geographic Regions Served 

Instructions: Please select the Geographic Regions that will be impacted by your project (Select all that 
apply).  

• (1.) Alaska (ARO)  

• (2.) Eastern (ERO) 

• (3.) Eastern Oklahoma (EOR)  

• (4.) Great Plains (GPR) 

• (5.) Hawaii (Hawaii) 

• (6.) Midwest (MWR)  

• (7.) Navajo (NRO) 

• (8.) Northwest (NWR) 

• (9.) Pacific (PRO) 

• (10.) Rocky Mountain (RMR)  

• (11.) Southern Plains (SPR) 

• (12.) Southwest (SWR) 

• (13.) Western (WRO) 

• (14.) Other (If “(14.) Other” is selected, please elaborate in the “Description of Needs and Barriers” 
Section 2.1.8) 

Note: For Section 2.1.6 Geographic Regions Served of the NE Offline Application Form, if you selected 
"Other,” it is recommended to provide the Census Tracts for the geographic regions served in Section 
2.1.8 Description of Needs and Barriers. 

Section 2.1.7 Zip Codes Served 

Instructions: What zip code(s) does this project serve? (625 character limit, approximately 125 words 

Note: For Section 2.1.7 Zip Codes Served of the NE Offline Application Form, please enter the 5-digit Zip 
Code(s). 

Section 2.1.8 Description of Needs and Barriers 

Instructions: To the greatest extent possible, provide data demonstrating the needs and barriers faced 
by the Native Entity's Covered Populations, including but not limited to the: 

I) The poverty rate of the Native Entity (i.e., the percentage of members of the Native Entity's 
population that live in the Covered Households as defined at 47 U.S.C. § 1721(7)) 

II) The number of Covered Populations to be served and the number of individuals within each 
Covered Population 

III) The number of individuals in the Covered Populations lacking access to a computer, tablet, 
smartphone, or other device that enables Internet access. 

IV) The number individuals within the Covered Populations not using or not subscribing to the 
Internet 
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V) Other data that demonstrates need 

Please explain the needs and barriers addressed in this project by highlighting here the best available 
data. If you are also applying for the Planning Grant Funds, indicate what data you will collect and why. 

Section 2.2 Planning Grant Funds 
Section 2.2.1 Planning Grant Funds 

Instructions: For Section 2.2.1 of the SDECGP NE Offline App Form, select Yes or No to answer the 
following question: ‘Are you applying for Digital Equity Planning Grant Funds?’  

If No, you are not applying for Planning Grant Funds, skip to Section 2.3 Capacity Grant Funds of the 
SDECGP NE Offline App Form. 

If Yes, you are applying for Planning Grant Funds, continue Section 2.2 Planning Grant Funds of the 
SDECGP NE Offline App Form. 

Sections 2.2.2 – 2.2.5 Digital Equity Plan Development 

Instructions: Digital Equity Planning Grant Funds: If the Native Entity seeks Digital Equity Planning Grant 
funds, provide a description of the specific planning activities the Native Entity intends to undertake and 
the manner in which these activities are consistent with 47 U.S.C. §1723(c), including a description of the 
outputs of these activities, a timeline for completing those activities, and a strategy to share the outputs of 
its planning activities, e.g., a Digital Equity Plan, with its respective community and the broader public. 
The Digital Equity Plan may include: 

I) A vision statement; 

II) Outreach and engagement with the Covered Populations for the purpose of identifying barriers to 
digital equity and conducting a needs assessment; 

III) Identification of the barriers to digital equity faced by the members of the Covered Populations; 

IV) Measurable objectives that address the barriers to digital equity; and 

V) Implementation strategies to achieve the measurable objectives identified above. 

Funding requested for planning activities must not exceed seven and one-quarter (7.25) percent of the 
total amount of funding being requested (i.e., total of both Digital Equity Planning Grant and Digital Equity 
Capacity Grant funds). Importantly, Digital Equity Planning Grant funding must be tracked separately from 
Digital Equity Capacity Grant funding. 

Note: Requests for Planning Grant Funds must not exceed seven and one-fourth (7.25) percent of the 
total amount of the requested funds. 

Section 2.3 Capacity Grant Funds 
Sections 2.3.1 – 2.3.2  

Instructions: Provide a description of the specific grant projects and activities to be funded by the State 
Digital Equity Capacity Grant Program, including the number of Covered Populations the proposed 
project(s) will serve and how they are consistent with the goals of digital equity and digital inclusion 
described in 47 U.S.C. §1723(d), and to the extent applying for Planning Grant Program funds, a 
description of how the Capacity Grant Program funds will be used to implement projects consistent with 
the Digital Equity Plan.  
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Note: All questions in Section 2.3 Capacity Grant Funds require a response.  

Section 2.4 Digital Equity Promotion 
Sections 2.4.1 – 2.4.5  

Instructions: Complete questions in Sections 2.4.1 – 2.4.5 Digital Equity Promotion of the SDECGP NE 
Offline App Form. 

Provide a description of how the proposed grant projects will address identified barriers to digital equity, 
the measurable objectives that will be used to assess progress towards overcoming these barriers, and 
how the proposed grant projects will promote, among the Covered Populations, the following: 

• The availability of, and affordability of access to, fixed and wireless broadband technology; 

• The online accessibility and inclusivity of public resources and services;  

• Digital literacy; 

• Awareness of, and the use of, measures to secure the online privacy of, and cybersecurity with 
respect to, an individual; and 50 

• The availability and affordability of consumer devices and technical support for those devices. 

Note: All questions in Section 2.4 Digital Equity Promotion require a response. If a question does not 
apply to the applicant’s proposed digital equity project, then the applicant can respond to this effect: “This 
project does not address this item.” 

Section 2.5 Project Size Variance 
Section 2.5.1 Variance in Project Size  

Instructions: For Section 2.5.1 of the SDECGP NE Offline App Form, select Yes or No to answer the 
following question: ‘Is the amount of requested Capacity Grant Funding less than $500,000 or more than 
$2,000,000?’ (see State Digital Equity Capacity Grant Program NOFO III.C.2.c.v). 

If No, the amount you are requesting is not less than $500,000 or more than $2,000,000, skip to Section 
2.6 Implementation of the SDECGP NE Offline App Form. 

If Yes, the amount you are requesting is less than $500,000 or more than $2,000,000, complete Section 
2.5.2 Explanation of Variance in Project Size of the SDECGP NE Offline App Form. For example: 
Geographic scope requires the requested funding to fall outside of the provided range. 

Section 2.5.2 Explanation for Variance in Project Size  

Instructions: Provide a reasonable explanation for the variance in project size if the amount of the 
requested funding is less than $500,000 or more than $2,000,000 (e.g., geographic scope requires the 
requested funding to fall outside of the provided range). (2500 character limit, approximately 500 words) 

Section 2.6 Implementation 
Sections 2.6.1 – 2.6.7 

Instructions: Complete 2.6.1 – 2.6.6 in Section 2.6 Implementation of the SDECGP NE Offline App Form 
(see State Digital Equity Capacity Grant Program NOFO III.C.2.c.vii-ix). 

For Section 2.6.6 Capacity Grant Sub-Granting or Sub-Contracting Process of the SDECGP NE Offline 
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App Form, select Yes or No to answer the following question: ‘Do you plan to use subgrantees and/or 
contractors?’ 

If No to Section 2.6.6, you are not planning to use subgrantees and/or contractors, skip to Section 2.7 
Anticipated Outcomes of the SDECGP NE Offline App Form. 

If Yes to Section 2.6.6, you are planning to use subgrantees and/or contractors, complete Section 2.6.7 
Capacity Grant Sub-Granting or Sub-Contracting Process Further Information of the SDECGP NE Offline 
App Form. 

Section 2.6.7 Capacity Grant Sub-Granting or Sub-Contracting Process Further Information 

Instructions: Provide a description of the implementation team and its experience with the 
programmatic/technical aspects of project management, the Native Entity’s organizational capacity to 
implement the proposed projects and meet key milestones, and a description of its proposed use of 
partners or other entities in implementation. In addition, provide a description of the sub-granting or sub-
contracting process to be followed, as applicable. 

Note: Submit one-page resumes of Key Personnel who will carry out and be responsible for the proposal 
activities.   

Section 2.7 Anticipated Outcomes 
Sections 2.7.1 – 2.7.4 

Instructions: Complete all questions in Section 2.7 Anticipated Outcomes of the SDECGP NE Offline 
App Form (see State Digital Equity Capacity Grant Program NOFO III.C.2.c.x-xi). 

2.7.4 Capacity Grant Project Plan 

Instructions: Provide a project plan describing all major project activities and timelines, including key 
milestones and when each major project activity will start and end. 

Note: Recommend limiting the comprehensive project plan to 5 pages for Section 2.7.4. 

Section 3 Funding Information 
Starting Section 3 Funding Information of the SDECGP NE Offline App Form, the applicant should 
disclose whether the Native Entity intends to use other funding sources to support digital equity and 
inclusion activities (State Digital Equity Capacity Grant Program NOFO III.C.2.xii). This should include 
funding the Native Entity has applied for.    

Section 3.1 TBCP Funds 
Section 3.1.1 Tribal Broadband Connectivity Program (TBCP) Application 

The following questions ask if the Native Entity applied and if applicable, been awarded Tribal Broadband 
Connectivity Program (TBCP) funding. 

Instructions: Select Yes or No to answer the following question: ‘Please indicate whether or not you 
applied for Tribal Broadband Connectivity Program (TBCP) funding.’ 

If No, you did not apply for TBCP funding, skip to Section 3.2 State Digital Equity Planning Grant Sub-
Recipient of the SDECGP NE Offline App Form. 

If Yes, you applied for TBCP funding, please continue Section 3.1 TBCP Funds in the SDECGP NE 
Offline App Form. Only complete Section 3.1.5 TBCP Grants Online Award Number if you were awarded 
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funding through TBCP. 

Note: This question pertains to rounds 1 and 2 of TBCP funding. 

Section 3.1.2 TBCP Grants.Gov Number 

Instructions: If applicable please list the Title and the Grants.Gov Grant Tracking Number 
(GRANT1345XXXX) of the application submitted. (Title, GRANTID) (100 character limit) 

Section 3.1.3 TBCP Award 

Instructions: Were you awarded funding through the TBCP or do you have a pending TBCP application? 
(Select 1 answer) 

If Yes, Awarded Funding (please complete Sections 3.1.4 – 3.1.5 to provide additional information) 

If Yes, Pending Funding (please complete Section 3.1.4 to provide additional information) 

If No (skip to Section 3.2 Planning Funds) 

Section 3.2 Planning Funds 
The following questions ask if the Native Entity was awarded funding as a sub-recipient to a State Digital 
Equity Planning Grant. 

Section 3.2.1 State Digital Equity Planning Grant Sub-recipient 

Instructions: Select Yes or No to answer the following question: ‘Were you awarded funding as a sub-
recipient to a State Digital Equity Planning Grant?’ 

If No, you were not awarded funding as a sub-recipient to a State Digital Equity Planning Grant, skip to 
Section 3.3 Other Funding of the SDECGP NE Offline App Form. 

If Yes, you were awarded funding as a sub-recipient to a State Digital Equity Planning Grant, please 
complete Section 3.2.2 State Digital Equity Planning Grant Further Information of the SDECGP NE Offline 
App Form. 

Section 3.2.2 State Digital Equity Planning Grant Further Information 

Instructions: List the awarded entity, a description of the corresponding project, a short description of 
awarded funds, and your role as a sub-recipient. (2500 character limit, approximately 500 words) (if 
applicable).  

Section 3.3 Other Funding 
Section 3.3.1 Federal Grant Awards for Digital Equity Past Awards 

The following questions ask if the Native Entity has been awarded any other Federal funding for digital 
equity and inclusion activities. 

Instructions: Select Yes or No to answer the question in Section 3.3 of the SDECGP NE Offline App 
Form: ‘Have you been awarded any other Federal funding, either through a competitive award/grant or 
formula funding, that provided funding for digital equity and inclusion activities such as broadband 
adoption and use, device programs, digital literacy and skills training, and internet subscription or device 
subsidy programs?’ 

If No, you were not awarded any other Federal funding, skip to Section 3.3.3 Federal Grant Awards for 
Digital Equity Past Applications of the SDECGP NE Offline App Form. 
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If Yes, you were awarded other Federal funding, list the awarding agency(ies) in Section 3.3.2 of the 
SDECGP NE Offline App Form. 

Section 3.3.2 Federal Awarding Agencies 

Instructions: List the awarding agency(ies) followed by the Program and year separated by a comma. 
(e.g., USDA, ReConnect Loan and Grant Program) (1250 character limit, approximately 250 words) (if 
applicable). 

Section 3.3.3 Federal Grant Awards for Digital Equity Past Applications 

The following questions ask if the Native Entity has applied for any other Federal funding for digital equity 
and inclusion activities, regardless of the status of the funding (e.g., pending review). Applicants should 
not repeat information captured in the preceding section, Federal Grant Awards for Digital Equity Past 
Awards. 

Instructions: Select Yes or No to answer the question: ‘Have you applied for other Federal funding, 
either through a competitive award/grant or formula funding, that provided funding for digital equity and 
inclusion activities such as broadband adoption and use, device programs, digital literacy and skills 
training, and internet subscription or device subsidy programs?’ 

If No, you did not apply to any other Federal funding, skip to Section 3.3.5 Philanthropic Awards for 
Digital Equity of the SDECGP NE Offline App Form. 

If Yes, you applied to other Federal funding, list the awarding agency(ies) in Section 3.3.4 Federal 
Agencies Applied To of the SDECGP NE Offline App Form. 

Section 3.3.4 Federal Agencies Applied To 

Instructions: List the awarding agency(ies) followed by the Program separated by a comma. (e.g., 
USDA, ReConnect Loan and Grant Program) (1250 character limit, approximately 250 words) (if 
applicable). 

Section 3.3.5 Philanthropic Awards for Digital Equity 

The following questions asks if the Native Entity receives any funding from private philanthropic 
organizations for comparable digital equity activities. 

Instructions: Select Yes or No to answer the question: ‘Did the applicant organization receive any 
funding from private philanthropic organizations for comparable digital equity activities?’ 

If No, you did not receive any funding from private philanthropic organizations, skip to Section 4 
Certifications and Assurances of the SDECGP NE Offline App Form 

If Yes, you received funding from private philanthropic organizations, proceed to complete Section 3.3.6 
Philanthropic Awards Further Information of the SDECGP NE Offline App Form.  

Section 3.3.6 Philanthropic Awards Further Information 

Instructions: If applicable list the philanthropic organizations, a description of the corresponding projects, 
and your role as a recipient. (2500 character limit, approximately 500 words) 
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Section 4 Certifications and Assurances 
In this section you will attest and certify each statement and assurance. Please refer to Section 4 
Certifications and Assurances of the SDECGP NE Offline App Form.  

Section 4.1 Use of Funds Certification: Certification that the Capacity Grant Funds and Planning Grant 
Funds (as applicable) will be used in a manner that is consistent with the purposes and requirements of 
47 U.S.C. 1723 and in the NOFO, and that, if the Native Entity seeks both Planning Grant and Capacity 
Grant funds, those funds will be budgeted and tracked separately. 

Section 4.2 Supplemental Funds Certification: Certification that the Capacity Grant Funds and 
Planning Grant Funds (as applicable) will be used to supplement, not supplant, other Federal or State 
funds that have been made available to carry out digital equity and digital inclusion activities. 

Section 4.3 Assurance 1: If an entity described in section 60305(b) is awarded grant funds under this 
section (referred to in this subsection as a “covered recipient”), provide that – 

(A) the covered recipient shall use the grant funds in accordance with any applicable statute, 
regulation, and application procedure; 

(B) the administering organization for that Native Entity shall adopt and use proper methods of 
administering any grant that the covered recipient is awarded, including by— 

(i) enforcing any obligation imposed under law on any agency, institution, organization, or 
other entity that is responsible for carrying out the program to which the grant relates; 

(ii) correcting any deficiency in the operation of a program to which the grant relates, as 
identified through an audit or another monitoring or evaluation procedure; and 

(iii) adopting written procedures for the receipt and resolution of complaints alleging a 
violation of law with respect to a program to which the grant relates; and 

(C) the administering organization for that Native Entity shall cooperate in carrying out any 
evaluation— 

(i) of any program that relates to a grant awarded to the covered recipient; and 

(ii) that is carried out by or for the Assistant Secretary or another Federal official  

Section 4.4 Assurance 2: The administering organization for that Native Entity shall— 

(A) use fiscal control and fund accounting procedures that confirm the proper disbursement 
of, and accounting for, any Federal funds that the Native Entity is awarded under this 
section; 

(B) submit to the Assistant Secretary any reports that may be necessary to enable the 
Assistant Secretary to perform the duties of the Assistant Secretary under this section; 

(C) maintain any records and provide any information to the Assistant Secretary, including 
those records, that the Assistant Secretary determines is necessary to enable the 
Assistant Secretary to perform the duties of the Assistant Secretary under this section. 

  

mailto:internetforall@ntia.gov


   

 

 

Page | 30 
internetforall.gov | internetforall@ntia.gov 

Internet For All 

Section 5 Consolidated Budget Forms 
Applicants must provide a Consolidated Budget Form (State Digital Equity Capacity Grant Program 
NOFO Section III.C.2.g). Applicants requesting Capacity and Planning Grant Funds must complete the 
“SDECGP NE CandP CBF,” while applicants requesting only Capacity Grant Funds must complete the 
“SDECGP NE Capacity CBF.” Complete and submit only one Consolidated Budget Form, depending on if 
the applicant is requesting Capacity and Planning Grant Funding, or just Capacity Grant Funding. Both 
versions of the forms are available for download on the Digital Equity Program webpage on 
www.InternetForAll.gov and found in the Native Entity Capacity & Planning Grant Program – Offline ZIP 
folder. 

Applicants are required to submit the Consolidated Budget Form that adequately represents all proposed 
activities, costs, and cost rationales for their grant-funded project. Please refer to the instructions and 
guidance outlined within the respective Consolidated Budget Form for more information.  

Applicants are required to attach the Consolidated Budget Form (saved as a .xlsx file) to the email 
submission or printed or loaded (saved as a .xlsx file) to a jump drive if sending by mail or courier. 

Note:  

• Applicants are encouraged to complete the Consolidated Budget Form in Microsoft Excel as there 
are embedded formulas that will assist applicants in correctly completing the form. Applicants will 
not need to be online to use the formulas embedded in the Excel document. 

• Applicants must ensure that the total project budget information (i.e., costs and totals) is 
consistent across ALL forms and templates that request budgetary information, including the SF-
424. 

Note on Printing the Consolidated Budget Form: If the applicant wants to print and mail their final 
application as a hard copy, the applicant is responsible for ensuring the way the Excel prints is legible. 
Additionally, the Consolidated Budget Form contains multiple tabs. To print all tabs, make sure to select 
“Print Entire Workbook”.  

  

Tips for Completing Budget Documentation 

• All budget amounts must exactly match across all budget documentation. For example, do not provide 
estimates or approximate amounts in the Consolidated Budget Form that do not exactly match amounts in 
the SF-424, and all relevant sections in the application 

• All subtotals and totals (including line items) should be exact and not rounded. For example, do not round 
unit costs ending in $0.50 or more up to the next whole dollar, and do not round unit costs ending in $0.49 
or less down to the nearest whole dollar.  

• All direct and indirect costs will be evaluated for allowability, allocability, and reasonableness according to 
the relevant cost principles. Only include costs that meet all of those criteria and note that additional detail 
or documentation may be requested. 
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Section 6 SF-424 
Applicants are required to fill out an SF-424 Application for Federal Assistance.  

The SF-424 template is available on the Digital Equity Program page on www.InternetForAll.gov and in 
the Native Entity Capacity & Planning Grant Program - Offline ZIP folder. Instructions on how to complete 
the SF-424 can be found on the grants.gov website, or at this link: 
https://www.grants.gov/web/grants/forms/sf-424-family.html 

Note: The SF-424 Line f. requests for a contact information on matters involving the application. This 
point of contact may be different from the Authorized Representative (AOR) that is identified later in the 
SF-424. The AOR is required to sign the SF-424 and submit the application.  

Section 7 Standard Forms 
This section will require applicants to complete all appropriate documents. All applicants are required to 
complete the CD-511. If applicable, applicants may also be required to complete the SF-LLL and provide 
a Negotiated Indirect Cost Rate Agreement. All additional documents should be signed by the AOR 
identified in the SF-424. Confirm that the name listed and the signature match. These forms must be 
attached to the email submission or printed if sending by mail or courier 

Section 7.1.1 Form CD-511 – Certification Regarding Lobbying 

The applicant must complete Form CD-511 Certification Regarding Lobbying that certifies that Federal 
funds have not been used and will not be used for lobbying in connection with this request for Federal 
financial assistance. A fillable Form CD-511 is available for download and filled out on the Digital Equity 
Program page at www.InternetForAll.gov and in the Native Entity Capacity & Planning Grant Program - 
Offline ZIP folder. Completion of this form is required for all applications. 
 
Note: The “Award Number” on the CD-511 should be NTIA-SDECGP-2024. 

Section 7.1.2 – 7.1.3 Standard Form-LLL – Disclosure of Lobbying Activities (if applicable) 

Answer the following: Do you need to disclose lobbying activities that have been secured to influence the 
outcome of a Federal action? (Select 1 answer) 

Yes (complete Section 7.1.3 Standard Form-LLL) 

No (skip to Section 7.1.4 Negotiated Indirect Cost Rate Agreement) 

The Standard Form-LLL- Disclosure of Lobbying Activities must be completed and submitted for those 
applicants that need to disclose lobbying activities that have been secured to influence the outcome of a 
Federal action. A copy of the SF-LLL is available for download on the Digital Equity Program page at 
www.InternetForAll.gov and in the Native Entity Capacity & Planning Grant Program – Offline ZIP folder. 

Sections 7.1.4 – 7.1.7 Negotiated Indirect Cost Rate Agreement (NICRA) (as applicable) 

Instructions: Select Yes or No to answer the question in Section 7.1.4: ‘Are indirect costs included in the 
proposed budget?’  

If Yes, complete Section 7.1.5 Negotiated Indirect Cost Rate Agreement (NICRA) of the SDECGP NE 
Offline App Form. 

If No, skip to Section 8 Attest and Submit of the SDECGP NE Offline App Form. 

Note: Consistent with 2 C.F.R. § 200.414(f), applicants that do not have a current negotiated indirect cost 
rate may elect to charge indirect costs to an award pursuant to a de minimis rate of 15% of modified total 
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direct costs, in which case a negotiated indirect cost rate agreement is not required. Applicants proposing 
a de minimis rate pursuant to 2 C.F.R. § 200.414(f) should note this election as part of the budget portion 
of the application.  

Additional instructions: For Section 7.1.5, select Yes or No to answer the following question: ‘Was an 
indirect cost rate established by a cognizant federal audit agency?’  

If Yes, proceed to Section 7.1.6 Negotiated Indirect Cost Rate Agreement (NICRA) of the SDECGP NE 
Offline App Form.  

If No, or if in the process of obtaining a NICRA, proceed to Section 7.1.7 Negotiated Indirect Cost Rate 
Agreement (NICRA) of the SDECGP NE Offline App Form, and indicated in the text box whether (1) you 
are in the process of obtaining a negotiated indirect cost rate agreement or (2) you are using the de 
minimis rate, described further in the note above. 

Section 8 Attest and Submit 
Once the applicant has completed the application, it is advised to proofread the materials submitted and 
verify the consistency of data provided in more than one location (particularly with respect to the project 
budget). The final Attestation & Application Submission section must be completed by the 
designated AOR in Form 424; the Attestation & Application Submission section is not accessible 
to other team member roles. The Offline Application must be submitted by the AOR. 

By submitting this application, the applicant certifies that the information and responses in the application 
are material representations of fact and are true and correct. 

The AOR is responsible for reviewing all forms and application documents before final submission. 

Review before Submitting 
Before submitting your application, please refer to Table 4: Summary of Documents for Submission and 
directions listed in the SDECGP NE Offline App Form to confirm that all required documents for your 
application package have been successfully included and properly formatted to validate completeness. If 
an applicant is mailing the application either include the documents in a .pdf or .xlsx on a jump drive or 
printed as part of a mail or courier submission.  

Table 4: Summary of Documents for Submission 

Offline App Form 
Section Document Name Submission 

Format Notes 

N/A SDECGP NE 
Offline App Form 

.pdf or 
printed 

Required for all Offline Applicants. Applicants must 
use the form provided on the DE website. 

1.2.2 Authorizing 
Documentation 

Authorizing 
Documentation 

.pdf  
or printed 

Required for all applicants.  

If applying as a single Native Entity, please provide 
a copy of the Native Entity governing body's 
authorizing documentation, demonstrating the 
authority to make an application on behalf of the 
Native Entity and designating the Authorized 
Organization Representative (AOR). 

If applying as a consortium of Native Entities, 
please provide the appropriate authorization(s) 
from each of the Native Entities listed within the 
Consortium Members Form that demonstrates the 
authority to make an application on behalf of each 
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Offline App Form 
Section Document Name Submission 

Format Notes 

of the Native Entities and designates the 
Authorized Organization Representative (AOR). 

Authorizing documentation should be in the form of 
a Tribal Resolution of Consent for Indian Tribes 
and for Alaska Native Entities, or, for other Native 
Entity Organizations, an equivalent formal 
authorization from the governing authority of the 
Native Entity. 

1.4.3 – 1.4.4 
Consortium 
Information  

SDECGP NE 
Consortium 
Members Form 

.xlsx  
or printed 

Required for consortium applications. Applicants 
should use the template provided on the DE 
website. 

Memorandum of 
Understanding 

.pdf  
or printed Required for consortium applications. 

1.5.2 Non-Profit 
Corporation 
Authorization  

Non-Profit 
Authorizing 
Documentation  

.pdf  
or printed 

Required for applicants that plan to use a non-profit 
corporation to administer NE Capacity & Planning 
Grant Funds. 

2.6.5 Resumes of 
Capacity Grant Key 
Personnel 

Resumes of 
Capacity Grant Key 
Personnel 

.pdf  
or printed Required for all applicants. 

2.7.4 Capacity Grant 
Project Plan 

Comprehensive 
Project Plan 

.pdf  
or printed 

Required for all applicants. The comprehensive 
project plan should describe all major NE Capacity 
Grant project activities and timelines, including key 
milestones and when each major project activity 
will start and end. Recommend limiting to 5 pages. 

5.1.1 NE Capacity & 
Planning 
Consolidated 
Budget Form 

SDECGP NE 
CandP CBF 

.xlsx  
or printed 

Required for applicants seeking Capacity and 
Planning Grant Funds. Applicants must use the 
template provided on the DE website. 

SDECGP NE 
Capacity CBF 

.xlsx  
or printed 

Required for applicants seeking Capacity Grant 
Funds only. Applicants must use the template 
provided on the DE website. 

6 SF-424 SF-424 .pdf  
or printed 

Required for all applicants. Applicants must use the 
template provided on the DE website. 

7 Standard Forms 

CD-511 .pdf  
or printed 

Required for all applicants. Applicants must use the 
template provided on the DE website. 

SF-LLL  .pdf  
or printed 

Required for applicants that need to disclose 
lobbying activities that have been secured to 
influence the outcome of a Federal action. 
Applicants must use the template provided on the 
DE website. 

Negotiated Indirect 
Cost Rate 
Agreement 
(NICRA) 

.pdf  
or printed 

Required for applicants where indirect costs are 
included in the proposed budget and the indirect 
cost rate was established by a cognizant federal 
audit agency. 
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Submit 

As a reminder, Offline Applications must be received by email no later than 11:59 p.m. Eastern Time 
(ET) on February 7, 2025, or sent by mail or courier postmarked no later than 11:59 p.m. Eastern Time 
(ET) on February 7, 2025. In all submittal scenarios, NTIA assumes the last submitted version of the 
application is the one to be reviewed. The AOR must submit the application. 

• Email: Offline Applicants should email all application content to the NTIA Digital Equity email box 
- digitalequity@ntia.gov and the email must be time stamped no later than 11:59 p.m. Eastern 
Time (ET) on February 7, 2025. Applicants are encouraged to list the name of the Organization 
and Grant Program in the email title. See Appendix B Email Submission of NE Capacity & 
Planning Grant Program Application for a proposed template to use for the email submission. If 
more than one email needs to be sent due to limited attachment capabilities, the applicant is 
encouraged to use the same naming convention for the email title and note in the body of the 
email this application material should be included in evaluation. If the applicant needs to send 
more than one email to provide NTIA with the full application, all emails must be received and 
time stamped no later than 11:59 p.m. Eastern Time (ET) on February 7, 2025. 

• Mail or courier: Offline Applicants must postmark their applications no later than 11:59 p.m. 
Eastern Time (ET) on February 7, 2025 and send the complete application package materials 
(printed or in a jump drive) to: 

Angela Thi Bennett 
Director of Digital Equity 
Office of Internet Connectivity and Growth 
National Telecommunications and Information Administration 
U.S. Department of Commerce  
1401 Constitution Avenue, NW  
Washington, DC 20230 
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5 Technical Instructions 
Applicants who decide to complete their application offline must confirm that the forms are properly 
downloaded, packaged, and submitted. Below are instructions on how to navigate Adobe, reduce file size, 
and print (if sending by mail or courier). 1,2 

5.1 How to Download Forms 
1. Download form to your Computer.  

a. Click the "Print" button: The Print button downloads a PDF of the filled form immediately 
with no further user interaction, after clicking on Print check your "Downloads" folder on 
your computer for "filename_filled.pdf" (where "filename" is the name of your original 
form). 

i. A message will tell you that the filled form is being generated. Once that 
message is not shown the PDF will be downloaded to your "Downloads" folder - 
the experience will be different depending on the web browser, often the file is 
downloaded with no further user interaction.  After clicking on "Print" check your 
"Downloads" folder on your computer for "filename_filled.pdf" (where "filename" 
is the name of your original form). 

b. Or click "Download as PDF" 

2. Next click "Download PDF to My Computer" 

3. The PDF of the filled form is created immediately and there is a message showing the progress: 

4. Once that message is not shown the PDF will be downloaded to your "Downloads" folder - the 
experience will be different depending on the web browser, often the file is downloaded with no 
further user interaction.  After clicking on "Download PDF to My Computer" check your 
"Downloads" folder on your computer for "filename_filled.pdf" (where "filename" is the name of 
your original form). 

Note: The document may automatically request to save a copy on your computer upon signing the 
form using the Digital ID function. 

5.2 How to Convert a Word Document into an Adobe PDF Document 
1. Open the Word document 

2. Click File > Save As 

3. Select a location to save the file 

4. Choose PDF from the drop-down list to save 

5. Click Save 

 
1 Adobe Acrobat, “Adobe Acrobat User Guide,” <https://helpx.adobe.com/acrobat/user-guide.html>, 
accessed Sept. 9, 2024. 
2 Microsoft, “Zip and Unzip Files,” Microsoft <https://support.microsoft.com/en-us/windows/zip-and-unzip-
files-f6dde0a7-0fec-8294-e1d3-703ed85e7ebc>, accessed Sept. 9, 2024. 
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5.3 How to Add Signature to Adobe PDF Document 
5.3.1 How to Add Signature Using Adobe Digital ID 

1. Click the Signature box to sign. 

2. Choose the Digital ID that you want to use for signing. 

3. Click Continue. 

4. Click Sign. 

5. Select a location to save the signed form > Click Save. 

5.3.2 How to Add Signature by Typing or Drawing in Adobe 

1. Click the Sign icon in the top toolbar. 

2. Click Add Signature in the sub menu. 

3. Choose one of the four options Acrobat Sign provides for adding an e-signature: 

a. Type your name 

b. Draw your own signature using your mouse or finger on a touchscreen 

c. Select Image to upload a picture of your own signature 

d. Select Mobile to capture your signature on your mobile device 

4. Click Apply. 

5. Move your mouse to the correct location and click once to place your signature. 

6. Click Done. 

Note: Once a PDF Is signed, the document can no longer be edited. If changes need to be made, a new 
form will need to be downloaded, completed, then signed. Signing should be the last step to validate all 
edits are included in the document. 

5.4 How to Reduce File Size on PC and Mac 
Applicants are responsible for ensuring their emailed application is successfully sent to NTIA. Large 
attachments may prevent emails from being successfully sent. To reduce file size of an attachment, 
applicants can compress PDFs or zip the files to send. Remember, NTIA must be able to open the 
application so do not password protect the zip files. Applicants should review all reduced files to confirm 
the file can be read. 

Note: Applicants sending via email should confirm file sizes are no larger than 20 megabytes (MB) total in 
size for successful delivery to NTIA. 

Instructions for Reducing File Size:  

1. Open the PDF in Acrobat. 

2. From the File menu, select Save As Other > Reduced Size PDF. 
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3. Choose the location to save the file and select Save. Acrobat displays a message showing the 
successful reduction in PDF size. 

5.5 How to Zip Files to Reduce Size on PC and Mac 
1. Locate the file or folder that you want to zip. 

2. Press and hold (or right-click) the file or folder, select (or point to) Send to, and then select 
Compressed (zipped) folder. 

3. A new zipped folder with the same name is created in the same location. To rename it, press and 
hold (or right-click) the folder, select Rename, and then type the new name. 

5.6 How to Search For Downloads and Open Documents on a Mac 
Applicants on a Mac device can easily view downloads and access using the following instructions. 

Instructions for Viewing Downloads:3 

Option 1: Using the Dock 

1. Look at the Dock (the bar at the bottom or side of your screen).  

2. Find the Downloads folder icon. It looks like a folder with a down arrow.  

3. Click on this Downloads folder. A pop-up will show your most recent downloads.  

4. To open the full Downloads folder, click Open in Finder at the top of the pop-up list.  

Option 2: Using Finder 

1. Click on the Finder icon (the smiling face in the Dock).  

2. In the Finder sidebar, you should see a Downloads folder under "Favorites."  

3. Click on Downloads to view all your downloaded files.  

Instructions for Accessing Documents:4 

Option 1: Using Finder 

1. Click the Finder icon in the Dock.  

2. In the Finder sidebar, click on Documents under "Favorites."  

3. This will open your Documents folder, where any saved documents should be located.  

Option 2: Spotlight Search 

1. Press Command (⌘) + Spacebar to open Spotlight Search.  

2. Type the name of the document you’re looking for.  

  

 
3 Apple Support, “Safari User Guide,” Apple < https://support.apple.com/guide/safari/download-items-
from-the-web-sfri40598/mac>, accessed Oct. 10, 2024. 
4 Apple Support, “Mac User Guide,” Apple < https://support.apple.com/guide/mac-help/open-documents-
mchl971293e1/mac>, accessed Oct. 10, 2024. 
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3. If it is saved on your Mac, it should appear in the search results. You can click on it to open the 
document directly.  

Additional Tips:  

To move a file (like from Downloads to Documents):  

1. Open Finder.  

2. Drag the file from the Downloads folder to the Documents folder in the sidebar.  

Customizing the Finder Sidebar: If you do not see "Downloads" or "Documents" in the Finder sidebar, 
go to the Finder menu at the top, click Finder > Preferences > Sidebar, and check the folders you want to 
appear.  

5.7 How to Attach a File to an Email Message in Outlook 
1. In a new message, a reply, or a forwarding message, select Attach File from the Include group on 

the Message tab. 

Note: You will only see Include on the ribbon when you select New mail, or after you select Reply, 
Reply all, or Forward on a received message. 

2. Select your file from one of the following locations: 

a. Recent items 
The 12 most recent files you have worked on will be displayed here. These files may be 
on your computer, on OneDrive, SharePoint, or another online document library. Select a 
file to attach it to your email. 

b. Browse Web Locations 
Locations include OneDrive, SharePoint sites, or other locations such as a groups 
document library that you have accessed before. Select one of the locations to open a 
new window and then select your attachment. 

c. Attach Item 
Gives you the option to include a Business Card or Outlook item. 

d. Browse This PC 
If you selected a file on your local computer or group document library, a copy of the file 
is attached to the email. Selecting a OneDrive or SharePoint file, however, provides you 
with additional permission options and information.  

3. If you selected a file on your local computer or group document library, a copy of the file is 
attached to the email. Selecting a OneDrive or SharePoint file, however, provides you with 
additional permission options and information. 

4. Send a link or send a copy: Sending a link to the OneDrive or SharePoint file keeps the size of 
your email message small. If you choose to send a copy of the file, the entire file is attached to 
the email, just like it would be if you selected a file on your computer. If you choose to send a link 
to the file, you can also set the permissions on your file. 

5. By default, if you are in a business environment, everyone within your organization can edit the 
linked file. To change these permissions, select the arrow at the right of the attachment name to 
display a drop-down menu with a variety of permission options. 
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a. Organization can Edit if you want anyone in your organization to be able to modify the 
file. 

b. Organization can View, if you want anyone in your organization to be able to read, but not 
modify, the file. 

c. Recipients can Edit if you want only the recipients of your email to be able to modify the 
file. 

d. Recipients can View if you want only the recipients of your email to be able to read, but 
not modify, the file.   

6. If Outlook detects that your recipients won't be able to view the file, for example if it is stored on a 
SharePoint site that is only accessible to you, you will see a warning message directly under the 
file icon and name. Select Attach as copy to change the attachment from a linked file to a copy of 
the file. 

5.8 How to Attach a File to an Email Message in Gmail 
1. In a new message, a reply, or a forwarding message, click the Paperclip Icon at the bottom of the 

screen5. 

Note: You will only see the paperclip icon when you select Compose, or after you select Reply, Reply 
all, or Forward on a received message. 

2. After clicking the Paperclip Icon, you will be prompted to select a file from the appropriate file path 
located on your PC. 

3. Once you have found the file, select it, and click ‘open’ for it to attach to the email.  

4. Click Send to complete the process once all necessary documents have been included and the 
message is finalized. 

5.9 How to Request a Read Receipt in Gmail 
1. Open Gmail and click Compose to write a new email message. 

2. At the bottom right of the compose window, click More options (the three dots or the triangle 
icon). 

3. Select Request read receipt from the menu. You will see a tick next to it. 

4. Send your message. Gmail will send a read receipt request to your recipient. If they accept, you 
will be notified that they read your email.  

Note: Applicants are responsible for ensuring their emailed application is not too large to send or be 
received by the Digital Equity email box. Applicants must check to confirm their email does not “bounce 
back”.  

  

 
5 Gmail Help, “Send Attachments with your Gmail Message,” Gmail < 
https://support.google.com/mail/answer/6584?hl=en&co=GENIE.Platform%3DDesktop>, accessed Oct. 
10, 2024. 
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5.10  How to Print  
Instructions for printing PDF files (for applicants who are submitting via mail or courier): 

1. Choose File > Print or click  icon in the toolbar. 

2. Select a Printer and number of Copies to print. 

3. (Optional) Click Properties to open the Printer properties. For more information, see your printer 
documentation. 

4. Under Pages to Print, select an option: 

a. All - prints all pages in the PDF. 

b. Current page - prints the current page in the PDF. 

c. Pages - specifies a subset of pages to print. You can enter individual page numbers, a 
range, or a combination. For example: 1, 6-18, 33, 98. 

d. More options - specifies additional options such as even or odd pages, and reverse 
pages. 

Note: As you change the settings, the print preview is displayed. Click the arrow buttons at 
the bottom to preview the other pages. If necessary, click Page Setup to change the paper 
size, paper source, or orientation. 

5. Click Print. 

5.11  How Print Multiple Tabs on Excel 
Print a partial sheet, an entire sheet, or an entire workbook: 

1. Perform one of the following: 

 To print a partial sheet, click the sheet, and then select the range of data that you want to 
print. 

 To print the entire sheet, click the sheet or the sheet tab. 

 To print a workbook, click any of its sheets. 

2. On the File menu, click Print. 

3. On the Printer menu, select the printer that you want. 

4. The default is to print all active sheets. To change what is printed, select Show Details. 

5. In the Print drop-down menu, select the option that corresponds to what you want to print 
(Selection, Active Sheets, or Entire Workbook) and then select Print. 
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Print several sheets at once: 

1. Select the sheets that you want to print. 

To select Do this 

Two or more adjacent 
sheets 

Click the tab for the first sheet. Then, hold down SHIFT and click the 
tab for the last sheet that you want to select. 

Two or more 
nonadjacent sheets 

Click the tab for the first sheet. Then, hold down COMMAND and 
click the tabs of the other sheets that you want to select. 

All sheets in a 
workbook 

Hold down CONTROL and click a sheet tab, and then click Select 
All Sheets on the shortcut menu. 

2. Note: When multiple sheets are selected, [Group] appears in the title bar at the top of the sheet. 
To cancel a selection of multiple sheets in a workbook, click any unselected sheet. If no 
unselected sheet is visible, hold down CONTROL and click the tab of a selected sheet, and then 
click Ungroup Sheets on the shortcut menu. 

3. On the File menu, click Print. 

4. On the Printer menu, select the printer that you want. 

5. Select Show Details. 

6. In the Print drop-down menu, select Active Sheets, and then select Print. 

Print selections from several sheets at once: 

1. On each sheet, select the range of data that you want to print. 

2. On the File menu, click Print. 

3. Select Show Details. 

4. In the Print drop-down menu, select Selection, and then select Print. 

Print several workbooks at once: 

Note: All of the workbook files that you want to print must be in the same folder. 

1. On the File menu, click Open. 

2. For adjacent files, hold down SHIFT and select the name of each workbook that you want to print. 
Or, for nonadjacent files, hold down COMMAND and select the name of each workbook that you 
want to print. 

3. On the File menu, click Print. 

Print an Excel table: 

1. Click a cell within the table to activate the table. 

2. On the File menu, click Print. 

3. Select Show Details. 
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4. In the Print drop-down menu, select Selection, and then select Print. 

Other print options: 

 Select Show Details in the Print dialog box to print to a PDF file, or to set which pages to print, 
paper handling options, margins, and scaling. 

 The Page Layout tab in the ribbon includes more options for page setup and printing, including 
page orientation, paper size and whether to print gridlines and headings. 
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Appendix A: Key Definitions  
• Applicant: Any eligible entity that applies to the NE Capacity & Planning Grant Program is 

referred to as an “applicant” in this document. Note: The applicant will be the entity listed on line 
8a. of the SF-424.  

• Authorized Organization Representation (AOR): An AOR is a member of the applicant 
organization authorized to submit applications in NGP on behalf of the organization. During the 
submission of the application, only the AOR will be able to attest that all statements are true 
before submitting the application. Note: The AOR will be listed at the end of the form “Authorized 
Representative” and will sign the SF-424.  

• Alaska Native Entity: The term “Alaska Native entity” will refer to a tribally controlled entity in 
Alaska whose purpose or mission is to represent or advance the interests of one or more native 
Alaskan communities. This will include, but will not be limited to, subsidiary organizations of an 
Indian Tribe; entities that receive federal funding due to their status as an Indian or Native 
organization; and the Alaska Native Regional Nonprofit Organizations created to administer 
social, educational, and health services for Alaska Native people in their region. 

• Indian Tribe: The term “Indian Tribe” means any Indian tribe, band, nation, or other organized 
group or community (i.e., Tribal Organizations), including any Alaska Native village or regional or 
village corporation as defined in or established pursuant to the Alaska Native Claims Settlement 
Act, 43 U.S.C. § 1601 et seq., which is recognized as eligible for the special programs and 
services provided by the United States to Indians because of their status as Indians. 

• Native Entity: As used in the State Digital Equity Capacity Grant Program NOFO, the term 
“Native Entity” refers to Indian Tribes, Alaska Native entities, and Native Hawaiian organizations 
as referenced in 47 U.S.C. 1723(i)(2) and that meet the eligibility criteria outlined in Section III.B.1 
of this NOFO. 

• Native Hawaiian Organization (NHO): An organization that is registered with the U.S. 
Department of the Interior’s Office of Native Hawaiian Relations and Hawaiian Homes 
Commission Act Beneficiary Associations and Homestead Associations, as defined under 43 
C.F.R. §§ 47.10 and 48.6, or is the Department of Hawaiian Homelands 
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Appendix B: Email Submission of Native Entity Capacity & 
Planning Grant Program Application 
 
From:  [Applicant Email] 
To:  digitalequity@ntia.gov 
Subject: [Organization Name] – NE Capacity & Planning Grant Program 
 
Dear NTIA NE Capacity & Planning Grant Program Team, 
 
On behalf of [Native Entity(ies) Name(s)], please find our Offline Application Form and 
respective documents attached for our application to the NE Capacity & Planning Grant 
Program. 
 
Thank you, 
 
[Applicant Name] 
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Appendix C: NTIA Grants Portal (NGP) Registration  
The following appendix provides information on how to register and use NGP: 

1. NGP can be accessed at https://grants.ntia.gov/grantsPortal/s/ 

2. Use one of the following browsers to access the Portal: (Refer to the Supported Browsers to 
Access the Portal page for more information) 

• Chrome Latest Release (Recommended) 

• Microsoft Edge Chromium (Recommended) 

• Mozilla Firefox Latest Release 

• Safari 

3. From the Grant Programs page, click the Learn More button under NE Capacity & Planning 
Grant Program to reach the home page. 

4. When you choose the Capacity Program on the landing page, you will be taken to the NE 
Capacity & Planning Grant Program home page. 

a. If you have not logged in, the button will show Log-in to Apply Now, which will redirect 
you to the login page. From here, return to the program home page and click Apply Now. 

b. If you are logged in, you can start your application for the NE Capacity & Planning Grant 
Program by clicking the Apply Now button.  

Log-in and Registration 
1. Click the Log-in button in the upper right corner to sign in as a registered Portal user or to 

register the first time you access the Portal. 

Registration 

1. If you have a Username and Password, enter the username and password and click the blue 
Log-in button to move forward. 

o If you forgot your password, click Forgot your password? Below the blue Log in button 
on the login screen. For assistance, email the NTIA Grants Portal Help Desk at 
ngphelpdesk@ntia.gov. 

o If you are new to the Portal and need to register for the first time, click Register below 
the blue Log in button. 

2. Complete the fields. A red asterisk (*) indicates a required field.  

3. Click the Entity Type field to select the entity type. Select your Entity Type. 

4. Enter your organization’s SAM.gov UEI.  

5. Then click the blue Sign Up button.  

Important: Upon completing registration, your Username will be the email address used to register for 
NGP appended with .ntia as the suffix. For example, the Username for the email address 
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JohnSmith@organization.com would be JohnSmith@organization.com.ntia. 

6. If the UEI entered matches an account within NGP, a message will appear with the organization 
the UEI matches. If it is the correct organization, click Submit to proceed. 

7. If the UEI that is entered does not currently exist in NGP system, you will be prompted to create 
an account.  

8. Complete the required fields and click Sign Up. 

Approval 
1. As part of the NGP registration process, approval is required. NTIA will send an approval email 

with a link to complete the process. 

2. Check your email inbox for an approval email, confirming your registration and providing steps to 
complete the registration and login process. 

3. In the event of receiving an email indicating you are not approved, contact NTIA for assistance by 
emailing NGPhelpdesk@ntia.gov. 

Registration Welcome Email with Initial Login Link 
1. Open your Welcome Email and click on the Login link.  

Important: Your Username is the email address used to register, appended with .ntia. Note this will be 
the Username used when logging in to the Portal in the future.  

2. You will be asked to Change Your Password. Enter a password according to the requirements 
indicated, and then click the Change Password button. 

Setting Up Multi-Factor Authentication 
After setting up your password, you will be asked to set up a verification method using Multi-Factor 
Authentication (MFA). Once MFA is set up, you will use it to verify your identity each time you log in.  

You will be guided in the subsequent steps to download and install an authentication app of your choice 
onto your mobile device from the app store. 

What is Multi-Factor Authentication? 

Multi-factor authentication (MFA) is a digital authentication method used to confirm the identity of a user 
to allow them access to a website or app through at least two pieces of evidence. With an authenticator 
app downloaded onto your mobile device, users are given an automatically generated code that refreshes 
around every 30 seconds. Using an authenticator app on your mobile device bolsters your online security. 

• Select the Salesforce Authenticator mobile app or another authenticator app of your choice (other 
types listed below in “Other Authenticator App” Section) – then click the Continue button. 

For more information about using the Salesforce Authenticator mobile app for multi-factor authentication, 
view this video: How to Use Salesforce Authenticator for MFA Logins 

Salesforce Authenticator Mobile App Verification 
If you selected to use the Salesforce Authenticator mobile app verification method, follow the instructions 
on the Connect Salesforce Authenticator screen, or use the following instructions. 
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Downloading and Installing the Salesforce Authenticator 

1. Search for Salesforce Authenticator in your phone’s app store. 

a. iPhone/iOS users will search in the Apple App Store 

b. Android users will search in the Google Play Store 

2. Follow your screen’s prompts to install the app on your phone. 

3. Open the Salesforce Authenticator app and follow the verification setup activities when you are 
prompted (mobile number verification, four-digit passcode setup). 

Connecting the Salesforce Authenticator to Your NTIA Grants Portal Login 

1. In the Salesforce Authenticator app on your mobile device, tap Add an Account. 

2. A unique two-word phrase will appear in the app, enter the phrase into the Connect Salesforce 
Authenticator screen and click Connect. 

3. Confirm the connection in the Salesforce Authenticator app and you will have successfully paired 
your account. 

Note: You will only need to connect your account once. You will continue to use the Salesforce 
Authenticator to approve future logins. 

Other Authenticator App 
If you selected to use another authenticator app (other than the Salesforce Authenticator App), follow the 
instructions on the Connect an Authenticator App screen. Commonly used Authenticator Apps 
available to download from the app store onto your mobile device include: 
• Google Authenticator 
• Lastpass 
• Microsoft Authenticator 
• Authy by Twilio 

• 2FA Authenticator 
• Duo Mobile 
• Aegis Authenticator 

Note: You will only need to connect (pair) your account once with an authenticator app. You will continue 
to use the authenticator app to approve future logins. 

Log into NGP Using the Connected Authenticator App 
Once you have installed and connected the authenticator app on your mobile device, you will continue to 
use the app to verify your identity each time you log into the Portal. 
1. Enter the Username you received during the registration process, which is your email address 

appended with .ntia, and the Password you created, in the fields provided into NGP from your 
computer web browser. The Portal will send a notification to your mobile device. 

2. The authenticator app will provide details of the login request, including Username, Service, Device, 
and Location. 

3. Review the login details, then tap Approve; if you do not recognize the request, tap Deny. 

Note: To make logging in easier, enable Always approve from this location from the Salesforce 
Authenticator to automatically approve requests matching location and login information. 
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